Chapter 13: Principles of
Neuropharmacol ogy

m Study of drugs that alter processes
controlled by the nervous system

— Peripheral nervous system drugs

— Central nervous system drugs
* Drugs used to treat:
— Depression
— Epilepsy
— Hypertension
— Asthma
— These types of drugs help the body to help
itself

m Neuropharmacologic drugs can:

— Mimic normal actions of body
neurotransmitters

— Block normal actions of body chemicals

— Modify actions of all body systems
» Skeletal muscles
» Cardiac muscle and output of blood
* Vascular tone
* Respiration
» Gastric function
« Uterine motility
* Glandular secretion
* CNS functions (heat, pain, mood, etc...)




m Neuron Function:
— Neuron, synapse, response organ

m Reflex arc:

— Sensory neuron, synapse, CNS, synapse,
motor neuron

m Response through brain:

— Sensory neuron, synapse, CNS spinal ganglia,
- brain, spinal ganglia, motor neuron

m 3 major steps in neuron action:
— Conduction of action potential
— Release of neurotransmitter from axon

— Binding of transmitter molecules to
receptors on post-synaptic cell

| .
m Action at synapse level
— Most neuropharmacologic agents act at
- synapse transmission level
» Axonal conduction NOT a common site of
action

— (local anesthetics decrease axonal conduction)
» Synaptic transmission site more selective

— Nerve action
- e Stimulus

» Change in polarity (de-polarization)
» Dendritic receptor - cell body > axon
transmission - synapse > response
— Synapse response different at different sites
» Different transmitters
» More than one type of receptor




m Resting Potential

— Resting nerve cell more positive on
. outside than inside

» Semi-permeable membrane
— Keeps Na* out and K* in until stimulus
e Stimulus causes Na* to diffuse in

— This changes polarity to more positive inside than
outside membrane

- — Stimulus then continues down dendrite/axon
* Repolarization

— To re-polarize, membrane becomes impermeable to
Na*® and permeable to K* and K* moves out from
nerve to create + charge outside and more negative
inside

— If this continues without the nerve allowed time to
PUMP K* back in and Na* out, then nerve
stimulation will ultimately stop due to inability to

_- de-polarize
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Semi-permeable membrane
De-polarization= movement of Na" into cell
Re-polarization= movement of K* out of cell




m Receptors

— Nerve synaptic transmitter diffuses
L across synaptic space and binds to
receptors on target cell
* Number of receptors on target cell will
determine the level of response to
transmitter
— Steps in synaptic transmission
- » Synthesis of transmitter molecules
» Storage of transmitter molecules in vesicles
* Release of transmitter molecules by action
potential into synaptic gap
* Receptor binding (reversible)

* Termination by release of transmitter from
receptor (uptake, enzymatic degradation,

n and diffusion)

m Drug action on receptors

— Enhance receptor activation
. * May increase effect by increasing release

* May activate receptor BUT decrease activity

— Actylcholine decreases heart rate when receptors
are activated

* Increase number of receptor molecules

— Reduce receptor receptor activation
- » Decrease response by decreasing release
» Down-regulating receptor number

— Transmitter synthesis

e |ncrease
e Decrease

e Cause synthesis of transmitter type that is more
effective than natural transmitter (higher affinity for
receptor)




— Interference with transmitter storage
e Can increase storage or decrease storage in
| vesicles
— Transmitter release

* Promote or inhibit release

— Amphetamines (CNS stimulant) increase
transmitter release

— Botulism toxin inhibits transmitter release
. Receptor binding
« Enhancement of binding (agonists)-
synergism of action- both bind to receptor
» Blocking binding (antagonists)- blockage of
receptor or lowering of affinity of receptor for
transmitter

m Drugs that that act at receptor level

] — Activation
* Morphine (effect on CNS)

* Epinephrine (effect on cardiovascular
system)

* Insulin (effect on diabetes)

* Benzodiazepines (Valium)- treats anxiety,

- seizure disorders and muscle spasm
— Inhibition

* Naloxone (treats overdose of morphine-like
drugs)

» Antihistamines (treat allergic disorders)

» Propranolol (treats hypertension, angina
pectoris, and dysrhythmias)




m Termination of transmitter action

— Blockade of transmitter reuptake
L * increase concentration of transmitter

—Inhibition of transmitter degradation
* Increase concentration of transmitter
m Multiple receptor types & Selectivity

— The greater the number of receptors, the
L greater the chances of obtaining
selective drug effects

m Drug action on receptors ***
— Type of receptor drug works on
—Normal response to activation of “R”
—What does the drug do to “R” function

|

m [soproterenol

— Reacts with b and b, receptor

L * Reaction with beta causes

— Increased heart rate and increased force of
cardiac contraction

* Reaction with beta 2 receptors causes
— Bronchial dilation
— Elevation of glucose levels in blood

] — Isoproterenol causes activation of both
types of receptors and elicits 3 types of
responses

* Increased cardiac output (increase rate and
force of contraction)

* Dilation of bronchi
» Elevation of blood glucose




Chapter 14: Physiology of PNS

m CNS- brain and spinal cord

m Peripheral Nervous System
— Somatic motor system

— Autonomic nervous system
— Sympathetic nervous system
— Parasympathetic nervous system

e 3 functions

— Regulation of heart

— Regulation of secretory glands (salivary, gastric,
sweat and bronchial glands)

— Regulation of smooth muscles (bronchi, blood
vessels, urogenital and gastrointestinal systems)

m Parasympathetic System

—Increases responses that are involved in
“recovery” phases
* Increase digestion
» Decrease heart rate
» Bladder and bowel emptying
* Focusing eye for near vision
» Contraction of bronchiolar smooth muscle

m Sympathetic System

—“Fight or Flight” responses
* Increase pupil dilation
* Increase heart rate
* Move blood from periphery to inner body
* Dilation of bronchi




— Most organs innervated by both para- and
sympathetic systems
] » Balance by opposition-
— heart rate
 Complementary control- increase overall
response or complement each other

— Erection is mediated by parasympathetic response
while ejaculation controlled by sympathetic nerves

 Innervation and regulation by only one of the
- two branches

— Blood vessels innervated only by sympathetic
nerves

m Requlation

— Feedback reflex

» Baroreceptor reflex- blood pressure
(receptors in carotid sinus and aortic arch)

— Autonomic tone

» Steady state, basal, level of tone
i — Muscle- neither fully relaxed or contracted

— Parasynpathetic nerves in most organs provide
basal level of control (predominant tone)

m Site of Druqg Action

— Parasympathetic
» Synapses between pre-ganglionic and post-
- ganglionic neurons
« Junctions between post-ganglionic neurons
and effector organs
— Sympathetic
» Synapses between pre-ganglionic and post-
ganglionic neurons

« Junctions between post-ganglionic neurons
i and effector organs




— Somatic Motor System

* Only one neuron and site of drug action is
| the neuromuscular junction

m Transmitters of PNS (~40 or more)

— Acetylcholine- released by

« all pre-ganglionic neurons of para-
sympathetic nerves:

- by all pre-ganglionic neurons of the
sympathetic system:

« all post-ganglionic neurons of
parasympathetic system

* All motor neurons to skeletal muscles

» Most post-ganglionic neurons of the
sympatheitic system that go to sweat

| glands

— Norepinephrine: released by

* All post-ganglionic neurons of sympathetic

| system
» Exception->Sweat gland nerves release
acetylcholine at junction

— Epinephrine:

* Major transmitter released by adrenal medulla
— Dopamine: not known conclusively— located

- in vasculature of kidney and activation of
receptors dilates renal blood vessels

m Receptors- distinct types and subtypes:
allow for selectivity of drug action
— Cholinergic- response to acetylcholine

— Adrenergic- response to epinephrine
B (adrenaline) and nor-epinephrine




Cholinengc recaplor sutilypes: My, = nicotinicy, My = Ricolinicy, and M= muscarinic.
Adrenargic racapior sublypes: o = alpha and 8 = bela.

Table 14-4 RECEPTOR SPECIFICITY OF
ADRENERGIC TRANSMITTERS

J
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mLife Cycle of Acetylcholine

» Synthesis of Ach from choline +
acetylcoenzyme A (Krebs cycle?)

Stored in vesicles
Released
Binds to receptors

Destroyed almost instantaneously by
acetylcholinesterase (AChE)

Choline released as end product and recycled
back into nerves for synthesis (not acetyl co-

A)
— Drugs act at:
* Botulism blocks Ach release
» Action at receptor level to block or mimic Ach

* Inhibition of AChE (Ach accumulates in
junction!!)

Acetate ==

Cholinergic
nerve terminal

Acetylcholing

P U
EHE_ J N—EHE"CHE_G— C -CH:L

/"

CH,
Chuh‘rle ¥
~ ACh
AChE
RECEPTOR Postjunctional cell
(Nicotinic or
muscarinic)
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mlLife Cycle of Epinephrine
— Synthesis of epinephrine within
L chromaffin cells of adrenal medulla

* Norepinephrine produced and then converted
to epinephrine (NOT PRODUCED IN NERVES)

» Epinephrine stored in vesicles in adrenal
medulla

» Released from adrenal gland
- » Travels in blood throughout body

* Hepatic metabolism destroys action of
epinephrine, not re-uptake by nerves

 MAO produces inactive product (what would
MAO inhibitors do?)

|
Phenylalanine o
. Adrenergic
Tyrosine ‘) k/nenfe terminal
Dopa
"y H H
DA | /!
@ HO :li-CHE—NR
HO OH H
MAD
- Norepinephrine
b 4 1
MNE Inactive H H
% NE A product | s
HO C—EHE—N\
NE | H
» % H OH h
ME

Epinephrine

Postjunctional cell
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Chapter 15: Muscarinic
Agonists and Antagonists

m Agonists-

— Drugs that bind to muscarinic receptors
and cause receptor activation

* (associated with parasympathetic system,
and effects mimic those produced by
parasympathetic stimulation)

14



m Bethanechol

— Reversible binding to muscarinic
cholinergic receptors and causes
activation (Table 14-2 for effects)

» Causes
— Bradycardia (decreased heart rate)
— Increased sweating
— Increased salivation
— Increased bronchiolar secretions
— Increased secretion of gastric acid
— Contraction of smooth muscles
— Increased motility of peristalsis
— Contraction of bladder
— Relaxation of vascular smooth muscle (hypotension)

— Near vision accomodation (near vision)
— Pupillary constriction

m Administered

« Orally
— Effects begin 30-60 minutes and last 1 hour

— To produce equivalent effect the oral dose must be
40X that of s.c. dose

* Injection s.c.
— Effects in 5-15 minutes and last 1 hour

» Has + charge and cannot get across
membranes of Gl tract well (small amount
absorbed)

m Therapeutic uses
* Relieves urinary retention

15



m Adverse Effects

* Hypotension & bradycardia
* Abdominal cramps & diarrhea

» Contraindicated for patients with asthma
(because of bronchiolar constriction

» Contraindicated for patients with
hyperthyroid conditions (dysrhythmias)
] m Dosage & administration

* Adult dosage: ORAL->10-50mg 3to 4
times/day

— 1 hour prior to meals or 2 hours after meals

» SCinjection-5 mg up to 4 times/day

g mToxicity if injected i.m. or i.v.

m Other muscarinic Agonists
— Pilocarpin- used for glaucoma

— Acetylcholine-dilation of pupil (lacks
selectivity and degraded quickly)

— Muscarine- mushrooms; not used
clinically
BY = Toxicology
—Mushrooms:: Inocybe and Clitocybe
species
— Treatment:: atropine (selective
muscarinic blocking agent

16



Muscarinic Antagonists

m Atropine

—Found in variety of plants
— Atropa belladonna and Datura stramonium

» Acts as competitive inhibitor of muscarinic
receptors (blocks ACh)

» High and low affinity receptors in different
organs
— Doses needed to block stomach and bronchiolar
smooth muscle higher than other organs

— Has opposite effect of agonists on heart,
exocrine glands and smooth muscles

— CNS-- mild hallucinogen and causes delirium
» High doses cause coma, respiratory arrest

_- and death
m Pharmacokinetics
« Administered orally, topically and by injection
[ (im, iv, sc)

» Goes to all tissues, including CNS
* Elimination by urinary mechanisms and liver
» ¥ life of about 3 hours

m Therapeutic uses

* Pre-anesthetic medication-

— slow heart rate due to stimulation of baroreceptors
can be reversed by atropine

* Eye examinations
» Bradycardia

» Used with morphine for gallstones to relax
biliary tract smooth muscle

» Peptic ulcer medication (reduces gastric acid)
» Asthma- blocks bronchiolar constriction

17



m Adverse Effects
* Dry mouth (xerostomia)
» Blurred vision and photophobia
» Elevation of intraoccular pressure
— Do not use in patients with glaucoma
 Urinary retention
— Void bladder prior to medication
» Constipation
— Decreased motility of Gl smooth muscle
— Anhidrosis
» Decreased sweating (at risk for hyperthermia)

m Drug interactions

* Avoid anti-histamines, phenothiazine
antipsychotics and tricyclic antidepressants
due to potential enhancement of atropine
effects

m Dose and Administration
* Oral tablets-- 0.4 to 0.6 mg
» Systemic dose-- 0.5 mg if by injection

m Other antagonists

» Scopolamine- sedation and suppression of
emesis and motion sickness

* Ipratropium- treat asthma and allergies
* Tolterodine- used for incontinence treatment

» Dicyclomine- used for irritable bowel
syndrome

18



Cholinesterase inhibitors and
their usein Myasthenia Gravis

m Drugs that prevent degradation of
Ach by acetylcholinesterase (AChE)
— Enhance action of Ach
- » Cholinergic agonists by indirect action

— Lack of specificity and therefore should
not be used widely for therapies
* Reversible vs non-reversible inhibitors

|
m Reversible AChE inhibitors
— Neostigmine
. » Carries a + charge and cannot easily cross
membranes (Gl tract, Blood-brain barrier, or
placenta)

 Splitting of neostigmine occurs more slowly
than hydrolysis of ACh, and AChE cannot act
on Ach until broken down

- * Intensify transmission at all junctions where
ACh is the transmitter

» Usually affects only muscarinic and nicotinic
receptors of the neuromuscular junction

— Increase glandular secretions, increase tone and
motility of Gl tract smooth muscle, urinary urgency,
and bronchiolar constriction

— Increase force of contraction of skeletal muscles (at
toxic levels force of contraction is reduced




— Pharmacokinetics

* Oral or injection

— Oral doses must be MUCH larger than parenteral to
elicit same effects

— Action lasts 2-4 hours
— Eliminated by enzymatic degradation

— Treatment of Myasthenia Gravis

e Accumulation of ACh at neuromuscular
junction, the ACh can reverse blockade due to
tubocurarine

— Good in post-operative patients

— Good in treatment of overdose with nondepolarizing
neuromuscular blockers

— Adverse effects - muscarinic stimulation & respiratory
depression

— Excessive salivation, inc gastric secretions, ....

— Neuromuscular blockade by causing excessive
depolarization

m Irreversible AChE Inhibitors

— Highly lipid soluble
— Get into CNS
— Absorbed through skin

— Structure of molecule similar for medication,
insecticide and for nerve gas!

* Bind to active site in AChE and prevent enzyme
from hydrolyzing ACh
— Effects continue until new AChE are made
» Can be reversed by Pralidoxime

— Used only in treatment of glaucoma

20



m Myasthenia Gravis

—Neuromuscular disorder
* Muscle weakness and rapid fatigue
» Ptosis=drooping eyelids
« Difficulty breathing (weakness of diaphragm)
» Autoimmune disorder due to Ab’s formed
against nicotinic,, receptors on skeletal
muscles: reduces number of receptors 70-
90%
— Treatment with neostigmine
* Increase muscle strength
* Not cure> symptomatic relief
» Use drug for rest of life

— Access ability to swallow (few sips of water) prior
to giving orally; if cannot swallow give parenterally

— Distinguish between
» Cholinergic crisis- overdose with AChE
inhibitor
And
* Myasthenic crisis- inadequate medication

— Patient should use identification
bracelet (Medic Alert)
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Chapter 17:
= Neuromuscular and Ganglionic
Blocking Agents

m Neuromuscular blocking agents

—Block at nicotinic,, receptors at neuro-
] muscular junction: cause muscle
relaxation

m Ganglionic blocking agents
—Block at nicotinicy receptors in autonomic
ganglia-

» Once used for hypertension but now replaced
by newer drugs

m Neuromuscular blocking agents

— Given to relax during surgery
L  Endotracheal intubation
* Mechanical ventilation

— Muscle contraction
» Polarization- + outside and - inside
» Depolarization- Na* diffuses in to make inside +

- * Repolarization- K* diffuses out to make inside —

— Action potential by motor neuron and ACh
stimulation of nicotinicy, receptors on motor end
plate > depolarization

— Calcium released (SR) allow interaction of actin and
myosin

— ACh dissociated, is degraded by AChE, end plate

repolarizes, Ca** reabsorbed into SR and muscle
relaxes
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m Blockers

— Classified by mechanism of action (non-
depolarizing and depolarizing) and time
course of action (long, intermediate, short,
and ultra-short)

— Non-depolarizing

* Tubocurarine (curare)- paralysis & death due to
respiratory paralysis
— Cannot cross membranes easily (parenteral, 1V)
— Cannot cross blood-brain barrier- no effect on CNS
— Cannot cross placenta — no effect on fetus
» Competes with ACh for binding to nicotinic),
receptors on motor end plate (does NOT mimic
but blocks ACh)
— Muscle relaxation
— Hypotension

|
— Adverse effects
* Respiratory arrest
[ | e Cardiovascular effects

— Drug interactions
* General anesthetics can enhance action

» Antibiotics can intensify response
(tetracycline and gentamicin)

* AChE can decrease effects of tubocurarine
(increase amount of ACh to compete for
receptor binding)

— Toxicology- overdose

* Prolonged apnea

* Massive histamine release

» Cardiovascular collapse
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Table 17-1 NEUROMUSCULAR BLOCKERS: TIME COURSE OF ACTION*
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m Dosage and Administration
— |V administration

- Only by specially trained clinicians
— 20 units/ml in solution
- » Adult initially gets 40-60 units at time of initial
incision: followed by 20-30 units w/i a few
minutes

-- Other Nondepolarizing Blockers
* Long acting

— Doxacurium
- — Metocurine
 Intermediate acting
— Atracurium
] * Short acting

— Mivacurium- maximal 2-5 minutes after IV, lasts 10-17

| . minutes
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m Depolarizing Blockers

— Succinylcholine

» Only depolarizing neuromuscular blocker in
clinical use

* Very short acting

 Binds to nicotinic,, receptors on motor end
plate and causes depolarization
* Remains bound to receptor and prevents
repolarization (constant depolarization)
» Causes brief contraction then paralysis
» Paralysis is only short lived
— Peaks at 1 minute after IV and fades w/i 4-10 min
— Degraded by pseudocholinesterase (in plasma)

» Used during endotracheal intubation,
endoscopy and other short procedures

m Therapeutic uses of neuromuscular
blockers
» Muscle relaxation during surgery
Facilitation of mechanical ventilation
Electoconvulsive therapy (depression)
Endotracheal intubation
» Diagnosis of myasthenia gravis

m Ganglionic Blocking Agents

— Lack selectivity & limited applications

» Used to lower blood pressure (only in special
circumstances)
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Table 17-2 PREDOMINANT AUTONORMIC TONE AND RESPONSES TO' GANGLIONIC BLOCKADE
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— Mecamylamine

* Interrupts impulse through ganglia of
autonomic nervous system

» Competes with ACh for binding to nicotinic)
receptors of sympathetic and parasympathetic

systems

» Stops all autonomic control of organs (Table

17-2)
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m Pharmacokinetics
* Well absorbed following oral administration
[ » Effect w/i 2 hours and last ~ 12 hours

* Lipid soluble
— Crosses blood brain barrier and placenta
* Eliminated through urine

— Therapeutic use
» Essential hypertension
] — Adverse reactions
* Antimuscarinic effects

* Hypotension

* CNS effects —tremor, convulsions and mental
abberations

Chapter 18: Adrenergic
“ Agonists

—Work by activating adrenergic receptors

» Similar reactions to stimulation by
sympathetic response (sympathomimetics)

e Mechanisms of action
* Direct receptor binding
» Promotion of norepinephrine release
* Blockade of NE uptake-increase in synapse
 Inhibition of NE inactivation- block action of
MAO

— All promote NE increase

| -
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m Table 18-1

Table 18-1 MECHANISMS OF ADRENERGIC
RECEPTOR ACTIVATION

Mechanism of

Stimulation Examples
Direct Mechanism : :
Binding to receplor to Epinephrine
cause activalion Isupmlt_:n:nul
Ephedrine®
Indirect Mechanisms .
Promaotion of NE release Ephedrine®
Amphelamines
lnhibition of NE reuptake Cocaine ;
Tricyclic antidepressants
Inhibition of MAD MAD inhibilors

amime MNE = imephrine.
MAD = monammine oxidase, NE = norcpinep el .
*Epheddne is a mixed-acting drug that activates receptors directly and also
promodes Teleass of norepinephrne.

W BN

m Adrenerqgic Agonists

— Catecholamines
» Contain catechol (benzene ring with 2—-0OH
groups) and amine groups
» Cannot be used orally: administered 1V, SM,
SC
* Discard when solution becomes discolored
— Non-Catecholamines
— Ephedrine
— Phenylephrine
— Terbutaline

» Degraded slowly by MAO
» Have longer ¥ lives than catecholamines
» Can be given orally

» Less polar and can penetrate blood-brain
barrier and effect CNS
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m Table 18-2

Table 18-2 RECEPTOR SPECIFICITY OF REPRESEMTATIVE ADRENERGIC AGONISTS
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m Therapeutic Applications

— Alpha, activation
* Vasoconstriction

— Blood vessels of skin, viscera and mucous
membranes

. » Stops bleeding (epinephrine topically)

» Nasal decongestion relieved by
vasoconstriction

» Helps with local anesthesia- slows absorbance
- by vasoconstriction
» Elevation of blood pressure

— Mydriasis- dilation of pupil
- — Adverse reactions
— Hypertension
— Necrosis due to lack of blood flow (extevasation

- around 1V)

— Bradycardia- slow heart




— Alpha, Activation
» Located pre-synaptically
 Activation inhibits NE release

— Activation of alpha, receptors in the periphery does
not have any clinical consequence
— Activation of alpha, receptors in CNS very
important
» Causes reduction of sympathetic response in
heart and blood vessels and cause slowing of
heart rate and vasodilation

— Beta, activation

 Activate Beta,; in heart to initiate beating in
heart that has stopped (cardiac arrest)

* Increase in force of contraction
* Improve blood flow when shock occurs

* Enhances impulse conduction through A-V
node (AV heart block)

| -

m Precautions & Contraindications

— Severe allergy: by blocking Beta,
receptors in heart and Beta, receptors in
lung by propranolol, the ability of
epinephrine to be used to counter
anaphylaxis will be impaired

— Diabetes: blockage of glycogenolysis will
prevent one mechanism for correcting
hypoglycemia in diabetes

— Cardiac, respiratory & psychiatric
disorders

m Drug Interactions
— Calcium channel blockers

—Insulin

30



m Summary

— Alpha,-Adrenergic Antagonists

* Pre-administration assessment
— Therapeutic Goal
» Reduction of blood pressure
» Reduction of symptoms in patients with BPH
— Baseline Data
» Determine blood pressure

» Determine degree of nocturia, daytime
frequency, intermittency, terminal dribbling,
urgency, size and force of stream, sensation of
incomplete voiding

— Identifying high risk patients
» Only contraindication is hypersensitivity to
these drugs

* Route & Administration
— Oral-take 1st at bedtime to avoid “first-dose effect”

_- — Most may be taken with food
— On-going evaluation
» Essential hypertension- monitor BP
[ * BPH- evaluate for improvement of symptoms

m Beta-adrenergic Antagonists

— Pre-administration assessment
» Therapeutic goal

— Indications are: hypertension, angina pectoris and
cardiac dysrhythmias

» Baseline Data
— Hypertension (standing and supine)
— Angina pectoris
— Cardiac dysrhythmias (baseline EKG)
 ID High Risk Patients- contraindicated for:
— Patients with sinus bradycardia or AV heart block
— Asthma, diabetes, severe allergic reactions
— Depression or those taking Ca*™ channel blockers
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* Route & Administration
— Oral (for most), IV for propranolol and some others
— Dose should be given 1-2 times per day
» Ongoing Evaluation
— Hypertension
— Agina pectoris
— Cardiac dysrhythmias
* Minimizing adverse reactions
— Bradycardia: if severe withhold medication and notify

- physician

— AV heart block: do not give beta blockers to patients with AV
block greater than first degree

— Heart failure: inform patients about early signs (shortness of
breath, night coughs, swelling of extremities, ...)

— Warn against abrupt discontinuation
— Inform about signs of hypertension

— Warn diabetic patients about NOT using tachycardia as an
early sign of hypoglycemia (masked by beta blockers)

|

m Beta, activation

e Action in lung and uterus
[ | — Asthma- beta, activation causes bronchodilation
— Terbutaline is more selective for beta, receptors
— Inhalation therapy minimizes systemic effects
— Delay of pre-term labor- relaxes uterine smooth
muscle
» Adverse effects

— Hyperglycemia- promotes breakdown of glycogen
- in liver and skeletal muscles to glucose

— Tremor- activation of beta, receptors in muscle
enhances contraction
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m Properties of Adrenergic Agonists
— Epinephrine

— Catecholamine
— Activates all 4 types of receptors
» Therapeutic uses
— Delay absorption of local anesthetics
— Control superficial bleeding
— Reduce nasal congestion
— Elevate blood pressure
— Induces mydriasis
— Overcome AV block & restores cardiac function
— Bronchiolar dilation in patients with asthma
— Treatment for anaphylactic shock
* Administered

— Topically, IV, inhalation NOT ORALLY
— Short % life

| .
m Adverse effects of epinephrine
» Hypertensive crisis
|  Dysrhythmias

* Angina pectoris
* Necrosis following extravasation
* Hyperglycemia
m Drug interactions- Do Not Use With:
— MAO inhibitors
— Tricyclic antidepressants
— General anesthetics
— Alpha adrenergic blocking agents
— Beta adrenergic blocking agents
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m Isoproterenol
* Reacts with beta, and beta, receptors

— Therapeutic uses

* Cardiovascular- AV heart block and increase
output

 Asthma- bronchiolar dilation

m Dopamine

» Dopamine and beta, receptors: and alpha, at
high doses

* Receptor specificity is dose dependent

— Therapeutic uses
» Shock

Chapter 19: Adrenergic
Antagonists

m Adrenergic Antagonists
— Cause direct blockade of adrenergic
receptors
» Reversible (competitive) block
— 2 major groups
» Alpha-adrenergic blocking agents
» Beta-adrenergic blocking agents




m Therapeutic applications of alpha
blockade

» Essential hypertension

— Block alpha receptors on arterioles and veins
causing vasodilation

* Reversal of toxicity from alpha agonists
» Benign prostatic hyperplasia (BPH)-

— benefits result from reduced contraction of smooth
muscle in bladder neck and prostatic capsule

 Pheochromocytoma-

— catecholamine secreting tumor in adrenal gland:
result in persistent hypertension

* Raynaud’s Disease
— Peripheral vascular disorder
— Spasms in toes and fingers

— Antagonist suppress symptoms by preventing
vasocontriction

— Adverse effects of Alpha blockers

» Orthostatic hypotension

— Reduces blood flow to brain causing dizziness,
lightheadedness and fainting (syncope)

— Due to vasodilation of veins lowering blood flow to
brain

» Reflex tachycardia

— Increase heart rate by stimulating baroreceptor
reflex which causes and increased heart rate to
compensate

* Nasal Congestion

— Dilates vessels of nasal mucosa
* Inhibition of ejaculation

— Alpha,, sympathetic reaction needed
» Sodium retention

— Decreased blood pressure decreases filtering by
kidneys and causes retention of water and salt
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m Other Adrenerqgic Antagonists
—Table 19-1

m Beta adrenergic antagonists

— Therapeutic Properties
* Result primarily from blockage of beta,
receptor in heart
— Reduced heart rate
— Reduced force of contraction

— Reduced velocity of impulse conduction through
AV node

» Angina Pectoris- pain in region of heart when
oxygen supply too low to meet needs of heart
— Exertion
— Intense emotion
* Hypertension
— Reduction of peripheral vascular resistance
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» Cardiac Dysrhythmias

— Due to high electrical activity in the SA node and
atria

» Decrease rate of SA node discharge

» Suppress conduction of atrial impulses through
the AV node

» Myocardial infarction (Ml)

— Reduction of pain, infarct size, mortality and risk of
re-infarction

— Must occur soon after Ml
» Heart Failure
» Hyperthyroidism

— Blocks increased sympathetic activity to heart
* Migraine

— Prophylaxis in lowering frequency of migraines

|
— Adverse Effects of beta, blockade
» Bradycardia
[ » Reduced cardiac output

» Heart failure

» AV block

* Long-term use can sensitize heart to
catecholamines. If withdrawn abrutly angina
pain and/or ventricular dysrhythmias can
develop=rebound excitation. Withdraw drug
gradually

— Adverse effects of beta, blockade
« Bronchoconstriction

* Inhibition of glycogenolysis (detrimental to
patients with diabetes
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m Propranolol
» Blocks beta, and beta, receptors
* Reduces heart rate
» Decreases force of ventricular contraction
e Suppress impulse through AV node

— Net effect=reduction in cardiac output

m Beta, blockade
* In kidney: suppresses secretion of renin

m Beta, blockade
* Lung: bronchoconstriction

* Blood vessels (only certain ones) ;: vaso-
constriction

» Skeletal muscle & liver: block glycogenolysis

m Summary of Implications

— Alphal-adrenergic Antagonists

* Pre-administration assessment
— Therapeutic Goal
» Reduction of blood pressure
» Reduction of symptoms of BPH
— Baseline Data
» Determine blood pressure

» Determine degree of nocturia, daytime frequency,
intermittency, terminal dribbling, urgency,
reduction in force and size of stream, sensation
of incomplete voiding

— ldentifying high risk patients

» Only contraindication is hypersensitivity to drugs
— Route & Administration

» Oral-- May be taken with food

» Initial dose at bedtime to minimize “first dose”
effect
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— Ongoing Evaluation
» Hypertension
» BPH- monitor for improvement
— Minimizing Effects
» Orthostatic hypotension- inform patients about

lightheadedness and dizziness and to move
slowly from sitting to standing

» First-dose effect- warn about driving after first
dose for 12-24 hours. Take first dose at
bedtime

— Beta-Adrenergic Antagonists

* Pre-administration assessment

— Therapeutic goal

» Hypertension, angina pectoris and cardiac
dysrhythmias

— Baseline Data
» Hypertension
» Angina pectoris
» Cardiac dysrhythmias

— ldentifying High Risk Patients: contraindicated for:

» Patients with sinus bradycardia of AV block
greater than first degree

» Caution inpatients with hart failure

» Patients with asthma, bronchospasms, diabetes or
severe allergic reactions

» Caution in patients with depression

» Caution in patients using Ca*™ channel blockers
— Route and Administration

» Oral (all except esmolol) and IV

» For hypertension administer 1-2 times per day

» Warn about abrupt discontinuation
— On-going evaluation

» Hypertension

» Angina pectoris

» Cardiac dysrhythmias
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— Minimizing adverse effects

» Bradycardia- beta blockers can reduce heart rate.

If severe withhold medication and notify
[ | physician
» AV block- beta blockers can decrease AV
conduction. Do not give to patients with greater
than 15t degree blockage of AV node

» Heart failure- inform patients about early signs of
heart failure (shortness of breath, night coughs,
swelling of extremities, etc...)

» Rebound cardiac excitation- abrupt withdrawal

- can cause tachycardia. Warn patients

» Postural hypotension- warn patients about
moving slowly from sitting to standing positions

» Diabetics- warn patients about NOT using
tachycardia as an early sign of hypoglycemia
since beta blockers may hide this symptom

» CNS effects- warn patient about possible
depression, insomnia and nightmares

Chapter 20: Indirect-Acting
. Antiadrenergic Agents

— Drugs that prevent stimulation of
peripheral adrenergic receptors but do so
by mechanisms that DO NOT involve
direct interaction with peripheral
receptors

- » Act to decrease norepinephrine release

» Act within CNS to reduce outflow of impulses
along sympathetic nerves

— Net result

» Reduction in stimulation of peripheral
adrenergic receptors (similar to drugs that
block receptors)
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m Reserpine

» Naturally occurring compound from shrub
indigenous to India

— Primary Indication

» Hypertension
— Can produce severe depression

— Mechanism of Action

» Depletes norepinephrine fro post-ganglionic
sympathetic neurons (decreases stimulation of
all adrenergic receptors— effects similar to
combinatin of alpha and beta adrenergic
blockade)

— Affects stored NE by exposing to degradation by
MAO

— Suppresses synthesis of NE by blocking uptake of
dopamine

— Also depletes serotonin (depression effects)

» Peripheral effects

— Slows heart rate and reduces cardiac output, and
causes vasodilation

— Results in decreased blood pressure

» Effects on CNS

— Sedation

— Causes sense of indifference to environment

— Severe depression

— Effects due to reduction in levels of seretonin and

catecholamines from brain neurons

* Therapeutic uses

— Hypertension

— Psychotic states (schizophrenia)- used rarely now
* Adverse effects

— Depression

— Bradycardia, orthostatic hypotension, nasal
congestion

— Increase acid formation in stomach and increase

narictalcic

41



m Centrally acting Alpha, Agonists

— Used primarily in hypertension

| — Reduce firing of sympathetic neurons and reduce
release of NE from sympathetic nerves

— Reduces pain of cancer (route is epidural infusion
{marketed under Duraclon})

— Drugs of choice
» Clonidine
» Antihypertensive that acts within CNS
- » Lipid soluble
— Route & Administration
— Administered by mouth or transdermal patch

— Adverse effects
— Drowsiness
— Xerostomia (dry mouth)
— Rebound hypertension

_- — Embrvotoxic
B Summary
— Pre-administration assessment
| — Therapeutic Goal

» Reduction in blood pressure
— Baseline Data

» Determine blood pressure
— ID high risk patients

» Contraindicated for patients with active peptic
ulcers

- » History of depression
— Route & Administration
— Oral
— Give with food to reduce gastric upset
— Evaluation of therapeutic effects
* Hypertensive effects may take 1 week or more
* Monitor blood pressure

| -
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* Minimizing adverse effects

— Depression: inform patients about signs of depression
(insomnia, loss of appetite, change in mood)

— Orthostatic hypotension-: inform patients to move slowly
from sitting to standing

— Summary of Clonidine

* Pre-administration assessment
— Therapeutic goal
» Reduction of blood pressure
— Baseline data
» Blood pressure
— ID high risk patients
» Embryotoxic- do not give to pregnant women
— Route and Administration
» Oral and transdermal
» Take at bedtime to avoid sedation during day
» Put patch on hairless, intact, skin on upper arm
» Apply new patch every 7 days

| -

Chapter 21. CNS
Phar macology

m Treatment of:

— Medical Uses
* Mental illness
e Suppression of seizures
* Relief of pain
* Production of anesthesia
— Non-Medical Uses
e Stimulant & depressant
* Euphoriant
* Mind altering abilities
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m Neurotransmitters

— Brain has more than 12 neurotransmitters

— Other sites have not had neurotransmitters
identified yet
* Dopamine
* Norepinephrine
e Serotonin
» Enkephalins

— Blood-Brain Barrier
* Impedes entry of drugs into brain
» Passage is limited to lipid soluble drugs

» Drugs cross by use of specific transport
systems

— Drugs that are protein bound and drugs that are
highly ionized cannot cross blood-brain barrier

|

* Protects brain from injury due to drugs

* Prevents drugs that need to get in from getting
- into CNS

* Blood-Brain barrier not completely developed at

birth
— Newborns more susceptible to drug actions than
adults

— Production of effects in CNS
* Not known but hypothesized

— Adaptation of CNS to prolonged exposure
* May be beneficial or harmful

» Therapeutic effects

— Drug must be taken for weeks before effects seen.
May be due to adaptive changes in brain, not from
direct effects of drug

— Decreased side-effects by adaptations of brain
— Tolerance and physical dependence




» Tolerance- a decreased response during
prolonged use of drug (decreased receptor
levels, increased degradation of drug)

» Physical dependence- state during which an
abrupt removal of drug will lead to severe
withdrawal symptoms). Brain must ADAPT back
to “normal” and during this time there are
withdrawal symptoms

* New drug development
— Lack of proper animal models

— Mentally healthy patients cannot be used to assess
potential of anti-psychotic agents

| -

Chapter 22: Drugsfor
Parkinson’s Disease

m Parkinson’s Disease

— A neurodegenerative disorder

— Extrapyramidal system-
» Dyskinesias- disorder of movement (leads to akinesia)
» Affects over 1 million Americans
— Symptoms
e Tremor
» Rigidity
» Postural instability
» Slowed movement
— Cause
» Loss of dopaminergic neurons in substantia nigra
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— Symptoms of PD

* Result from disruption of neurotransmission
within the striantum

* Requires a balance between 2 transmitters

— Dopamine: inhibitory transmitter-> neurons that
release dopamine inhibit neurons that release
gamma-aminobutyric acid (GABA, an inhibitory
transmitter)

— Acetylcholine: excitatory transmitter = neurons that
release ACh excite the neurons that release GABA

— Neurons that supply dopamine originate in the
substantia nigra
* In PD there is a degeneration of the neurons
that supply dopamine to the striatum (why is
unknown), and ACh stimualtion is not balanced
by dopamine, and too much GABA released

— Therapeutic Goal
* Improve patient’s ability to carry out daily
activities
» Drugs provide only symptomatic relief, not a
cure

» Selegiline- only drug that may alter progression
of disease

— Treatment strategy

* To regain balance of dopamine and ACh

— Use agents that directly or indirectly activate
dopamine receptors

— Use agents that block ACh receptors
» See Table 22-1 for drugs that are used in PD
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m | evodopa

— Beneficial effects

» 75% of patients respond with a 50% reduction
in symptoms

* If patient fails to respond to levodopa, then it
should be questioned as to whether PD is the
diagnhosis

— May take months to fully respond-- inform patient of
this
* Long-term treatment disappointing

— 18t two years symptoms controlled, by end of 5 years
deterioration occurs. Due to progression of disease,
not due to tolerance or adaptation???

— Gradual loss ys abrupt loss of effect > can be
minimized in two ways

» Shortening the dosing interval
» Giving drug that prolongs % life (tolcapone)
» Giving a direct-acting dopamine agonist
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— Mechanism of action of Levodopa
* Promotes synthesis of dopamine in striatum

» Enters brain by active transport

— Once in brain it is taken up by the few remaining
dopaminergic nerve terminals that remain

— Converted to dopamine by enzyme decarboxylase, the
activity of which is enhanced by pyridoxine (vitamin B6)

— Balances Ach
* Administered orally and rapidly absorbed from
small intestine (food delays absorption)
— Only 2% of dose reaches brain

» Adverse Effects (1° in elderly)
— Nausea and vomiting

— Dyskinesias- 80% develop other involuntary movements
(head bobbing, tics, grimacing) w/l first year

— Cardiovascular effects: hypotension
— Psychosis: 20% of patients

* Drug holidays

— Stimulation may improve after long-term use with a
holiday (10 day interruption)

—Drug and food interactions

— Antipsychotic drugs: agents that block dopamine
receptors should not be used (many of current drugs
do this)

— MAO inhibitors: levodopa can cause a hypertensive
reaction (MAO inactivates dopamine and NE, and
levodopaincreases these, therefore an inhibitor of
MAO would increase these too much)

— Anticholinergic drugs: since excessive levels of ACh
contribute to symptoms, anticholinergic drugs would
enhance therapeutic effects

— Foods with high protein content compete with
levodopa for absorption in intestine and lower
levodopa absorption

— Carbidopa- (Sinemet) enhances effect of levodopa by
inhibiting decarboxylases in periphery

48



* With Carbidopa:
— Can decrease dose of Levodopa by 75%

— Reduces nausea and vomiting by reducing dopamine
production in periphery

— No adverse effects of Carbidopa
» Dose and Administration
— Combination tablets (sustained release)= Sinemet

m Summary- Levadopa and Carbidopa

— Pre-Administration Assessment

* Therapeutic Goal

— Improve patient’s ability to carry out activities of daily

living

» Baseline Data

— Assess overt manifestations of PD

» Bradykinesia, akinesia, postual instability, tremor,
rigidity)

* ID high risk patients

— Contraindicated for patients with malignant
melanoma (can activate neoplasm)
— Contraindicated for patients taking MAO inhibitors

— Caution in patients with cardiac disease and
psychiatric disorders
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* Route and Administration
— Oral
— Can be taken with food, but avoid foods with high
protein content
» On-going evaluation
— Evaluating therapeutic effects: improvements in
handling every day activities
— Managing acute loss of effect (after long-term usage)

* Minimizing Adverse Effects

— Nausea and vomiting: inform patient that taking drug
with food can alleviate these symptoms

— Dyskinesias: inform patients about possible
movement disorders

— Dysrhythmias: inform patients about signs of
excessive cardiac stimulation

— Orthostatic hypotension: inform patient
— Psychosis: inform patient

|
Chapter 23: Drugsfor Epilepsy
" mEpilepsy

— Disorders characterized by excessive
excitability of neurons with CNS
» Brief unconsciousness
* Violent convulsions
» 2.3 million people in US have diagnosed
epilepsy
» 300,000 are under age 14
* 50% of people can be seizure free by using
drugs and 25% can have reduced symptoms
— Seizure- all types of epileptic events

— Convulsion- abnormal motor responses
» Jerking movements in grand mal seizure
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m Seizures

— Initiated by high-frequency discharge from
agroup of excitable neurons called a
FOCUS

* Focus caused by:
— Congenital defects
— Hypoxia at birth
— Head trauma
— Cancers

* Symptoms depend upon location of FOCUS

and how discharge spreads to other portions of
brain

m Types of seizures

— Partial (focal) seizures
e Simple partial seizures
— Convulsions in single limb or muscle group
» Complex partial seizures
— Involve impairment of consciousness

— Generalized seizures

* Produce immediate loss of consciousness

— Tonic-Clonic seizures (Grand Mal): discharge
throughout total cerebral cortex

» Major convulsions
» Muscle rigidity (tonic phase)
» Synchronous muscle jerks (clonic phase)
— Absence seizures (Petit Mal):
» Loss of consciousness for brief time (10-30 sec)
» Mild eye blinking
» Occur in children and disappear by teens
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m Antiepileptic Drugs & how they work

— AEDs suppress discharge of neurons
within a seizure FOCUS

— Suppress propagation of seizure activity
from FOCUS to other areas of brain
» Act through:

— Suppression of sodium influx:
» reversibly bind to sodium channels
— Suppression of calcium influx:

» T-type calcium channels in hypothalamus;
drugs block this channel to prevent absence
seizures

— Potentiation of GABA

» Inhibitory transmitter (GABA) and by
augmenting GABA responses (binding to
receptors, promoting GABA release, inhibiting
enzyme degradation of GABA, or re-uptake

m Therapeutic Goal

* Reduce seizures to allow patient to live normal
life
* Eliminate seizures (ideal)
— Select drug for specific disorders (T 23-1)
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m Making Diagnosis
— Requires
* Physical neurologic and lab evaluations and
complete history
— Age of onset of seizures
— Frequency and duration of seizure activity
— Precipitating factors
— Times when seizures occur
— EEG for diagnosis of seizure type
e Until drug evaluation done make sure patient
does not participate in activities that could be
dangerous if seizure occurs
— Trial period

— Dosage adjustments
— Measurement of plasma levels of drug
— Seizure frequency chart

| .
— Promote Compliance in Patient
» Educate patient and family
[ | * Monitoring plasma drug levels

e Seizure frequency chart

— Spontaneous remission

« Some forms of epilepsy will spontaneously go
away

» Withdrawal of drugs must be done over and
extended period of time (6 weeks to several
months). If patient using two drugs then they
must be withdrawn sequentially not
simultaneously
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m Antiseizure therapy during pregnancy

— Some risk of in utero exposure to AEDs
.  First trimester most important

e Must balance risks involved
— To mother and health
— To baby and harm from convulsions vs medication
* Women with major seizures should continue
medication throughout pregnancy
- — Take lowest effective dose

— Considerations
* Renal excretion and hepatic metabolism
increase during pregnancy (increase dosage
needed?)
 Valproic acid and carbamjazepine associated
with higher incidence of neural tube defects
— Treatment with folic acid (5 mg/day) reduces this




Chapter 24. Drugsfor Muscle
Spasm and Spasticity

m Muscle spasm

—Involuntary contraction of a muscle of
muscle group
* Painful
» Decreases level of functioning
— Epilepsy
— Hypocalcemia

— Acaute and chronic pain syndromes
— Trauma: muscle inury
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m Spasms due to muscle injury
* Immobilization of affected muscle
» Application of cold compresses
* Whirlpool baths
* Physical therapy

— Drug therapy
» Analgesic anti-inflammatory agents
— Aspirin
» Centrally acting muscle relaxants

— High doses suppress spinal motor reflexes (too high
to be used in humans)

— Sedative properties of drugs

» Diazepam and Tizanidine— enhance pre-synaptic
inhibition of motor neurons in CNS

» Diazepam - enhances effects of GABA
» Tizanidine- promotes ingibition by acting as an

_- agonist at pre-synaptic alpha, receptors
m Adverse effects
— CNS depression-

. » drowsiness, dizziness, lightheadedness

— Hepatic toxicity
» Assess liver function before and after
treatment

— Physical dependence-

» With chronic high dose therapy, if drugs
abruptly withdrawn

m Drugs for Spasticity

— CNS origin: due to MS and cerebral palsy
» Heightened muscle tone
e Spasm
» Loss of dexterity
* Traumatic spinal cord injury and stroke
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m Drug action

— Baclofen

* May mimic action of GABA
— Diazepam (Valium)

* Mimic action of GABA
— Dantrolene

» Acts directly on skeletal muscle by
suppressing release of calcium from SR
— No effect on smooth muscle and cardiac muscle

B Summary

— Therapeutic Goal
* Releif of signs and symptoms of muscle
spasm
— Identify high risk patients
* Avoid chlorzoxazone, metaxalone and
tizanidine in patients with liver disease
— Minimize adverse effects
* CNS Depression-inform patient

» Hepatic toxicity- determine liver function
before and after treatment
* Do not use
— Alcohol
— Antihistamines
» Withdraw gradually
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Chapter 25. Drugsfor

Headache
m Headache
—Induced by:
e Stress eye disorders
» Fatigue hypertension
* Acute illness hyperthyroidism
» Alcohol infection
— OTC medications can treat mild
headaches

— Determine cause of headaches
e can cause be eliminated

|
m Migraine
 Unilateral, throbbing or nonthrobbing head
[ pain, often associated with nausea,

vomiting, photophobia and phonophobia
» Usually develop in morning
» Persists for hours to days

— Migraine with aura (classic migraine)
* Visual flashes

— Migraine without aura (common
migraine)
» 80% of people get this
* 60-70% are women in late teens > 30 years

» Worse during menstruation and subside
during pregnancy and cease after
menopause
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m Pathophysioloqgy

— Result from

* Inflammation and dilation of intracranial blood
vessels

— Calcitonin gene related peptide (CGRP) and
serotonin (5-HT)

» CGRP- promotes migraine
» Plasma level rises during migraine attack
» Sumatriptan, lowers elevated levels of CGRP

» CGRP causes release of inflammatory
neuropeptides

» 5-HT suppresses migraine
» Plasma levels drop by 50% with migraine

» Reserpine lowers levels of 5-HT and causes an
attack

» Treatment with 5-HT or sumatriptan stimulate 5-
HT receptors and suppress migraine
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